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1 Introduction 
Vmed Technology’s PC-Display software is designed for Microsoft Windows™ computers 
to allow the Vmed wireless monitors to display and record their monitoring data. The 
Bluetooth connection established between a Vmed wireless monitor (or remote) and the 
computer allows for a wireless data transfer so that the monitoring device will be out of 
the way of the clinical procedure. 

 

The PC-Display monitoring screen displays numerical and charted data for up-to-the-
moment measurements of the patient’s vital signs. Additionally, PC-Display can record 
this data into a proprietary file format that can then be opened and viewed using Vmed’s 
own Reviewer or Interpreter software. 

 

In order to make use of your Vmed wireless monitor with PC-Display you will first need to 
initialize the Bluetooth and pair your wireless monitor with your computer. Follow the 
instructions given in section 2 for this. 
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2 Initial Connection 
In order to connect to your Vmed wireless monitor for the first time you will need to prepare 
your Windows computer for Bluetooth connectivity. Follow the below procedures in order 
to allow your computer to communicate with your Vmed wireless monitor. 

 

2.1 Bluetooth Installation and Pairing 
 

NOTE:  
Because Windows 10 is now the only operating system supported by 
Microsoft, this manual assumes that you are using Windows 10. If you 
are using an earlier version of Windows then refer to the following 
instructions for installing and pairing a Vmed wireless device here: 

https://www.vmedtechnology.com/customers/pdf/Legacy_Windows_Bluetooth.pdf 

 

2.1.1 Bluetooth Adapters 
Each Vmed wireless remote monitor is shipped with a USB Bluetooth adapter (sometimes 
known as a “dongle” or external Bluetooth adapter) in order to facilitate the wireless 
communication between your computer and the wireless remote device. However, some 
computers are manufactured with a built-in or internal Bluetooth adapter. Since Windows 
will only allow Bluetooth communication with one active Bluetooth adapter at any given 
time then you may need to determine the following. 

 

External or Bluetooth USB Adapter (“dongle”) 
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2.1.1.1 Does My Computer Have Built-in Bluetooth? 
 

Use the following steps to determine whether your computer already has internal 
Bluetooth. 

 

1. Make sure that no USB Bluetooth adapters are currently plugged into your 
computer. Then right-click your mouse or mousepad on the Windows button 
(sometimes known as the “Start” button). By default, it is located at the bottom 
left corner of your screen.  

 

2. A menu of options will appear above it. Select “Device Manager”. 
 
 

3. A Device Manager window will appear. Look near the top for a category named 
“Bluetooth”. You may even expand this category to reveal a list of items such as 
below. 
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If the Bluetooth category exists in the Device Manager window similar to the above image 
then you likely do have an internal Bluetooth adapter present in your computer. If not then 
you do not have that feature. You may then proceed by inserting the USB Bluetooth 
adapter to your computer and allow time for it to be recognized by Windows and for its 
device drivers to be automatically installed. You may then skip to section 2.1.2 below. 

NOTE: 
Bluetooth adapters are interchangeable with each Vmed wireless 
remote. In fact, you may pair up to 6 Vmed wireless remotes to each 
computer using a single Bluetooth adapter (either internal or external). 
Vmed recommends that each monitoring computer have its own 
Bluetooth adapter. 

 

2.1.1.2 Which adapter should I use? 
There are certain advantages and disadvantages to using each type of Bluetooth adapter. 
If both are available, use the following table to help you decide which one fits your 
situation best. Keep in mind also that many off-the-shelf USB Bluetooth adapters may 
work just as well as the one supplied with your Vmed wireless monitor. 

 

Advantage Internal Bluetooth Vmed USB Bluetooth Adapter 
Best signal strength 1   
Doesn’t risk getting bumped into and broken   
Guaranteed to work with Vmed monitor 2   
Easier initial setup 3   
Requires less configuration 4   

¹ Vmed USB adapter is rated up to 100 meters while most internal Bluetooth adapters are rated up to 10 meters. 
2 Some internal Bluetooth adapters are not compatible with Vmed monitors. 
3 If an internal Bluetooth adapter is present when the USB adapter is desired then the internal adapter must be disabled prior to 
setting up the USB adapter. 

4 See section 2.1.3 for additional configuration for internal Bluetooth adapters 
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2.1.2 Bluetooth Pairing 
In order to connect to each Vmed wireless monitor it must first be paired with that 
monitoring computer. Follow the below procedure to pair each wireless remote. 

1. Double-click the Bluetooth tray icon to open the Bluetooth Devices window. 

 

2. Turn on the wireless remote. 

 

3. Click the "Add Bluetooth or other device" button at the top of the window. 
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4. Select "Bluetooth" from the "Add a device" window. 

 

5. Wait for your Vmed wireless device to appear and click it (note that it will be 
named “Vmed-“, followed by its ID number listed on its back label; in this case it 
is “Vmed-VG20123”). 

 

6. When asked for a "PIN" for this remote, enter the word "default", then click 
"Connect". This PIN is case-sensitive. 

 

10 

7. Once the pairing is finished, click "Done". 

 

 
If you are using Internal Bluetooth then continue to section 2.1.3. Otherwise, skip to 
section 2.2. 

 

 

2.1.3 Configuring PC-Display for Internal Bluetooth 
Once your Vmed wireless remote has been paired with your computer’s internal Bluetooth 
adapter then you will need to configure PC-Display to know which COM port Windows 
has assigned to each remote. 

1. From the Bluetooth Devices window click the "More Bluetooth options" link 
beneath the “Related settings” category to open the Bluetooth Settings window. 
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2. In the Bluetooth Settings window select the “COM Ports” tab. Then, look for the 
"Outgoing" line for your newly paired remote (notice the Bluetooth name on the 
right side). Note the COM port number on the left (in this case, it is COM 3). 

 

3. Double-click the PC-Display desktop icon to open PC-Display. 

 

4. When the "A Wireless Remote was not found" error appears within PC-Display 
click "Cancel". 
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5. Open the "Tools" menu and select "Edit Default Configuration". 

 

6. In the “Product Configuration” window put a check mark in the box next to 
"Specify Com Port Number?" (a) and then enter a non-zero number in the box 
that appears to the right of it (b). 

 

7. Click "OK" to the Product Configuration window and then close PC-Display 

 

8. Open PC-Display once more. 

 

9. At the "Vmed Remote Switcher" window click the "Configure" button. 
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10. When the "Configure Vmed Remotes" window appears first select the type of 
remote that you just paired (in this case it is a “VetGard+”). 

 

11. Enter a name in the box next to it (recommended: the remote's ID). 

 

12. Enter the number of the COM port noted in step 2. 

 

13. Click "OK" button and "Yes" to save these values. 
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2.2 Wireless Connection 
Your Vmed wireless monitor should now be ready for its connection to PC-Display. Follow 
the below instructions whether you are using internal or external Bluetooth. 

1. Verify that your Vmed wireless remote is still turned on - if not then turn it on 
once more. 

 

2. Open PC-Display if it is not already open by double-clicking its Desktop icon. 

 

3. At either the "Select Wireless Remote Connection" or "Vmed Remote Switcher" 
window make sure that the Vmed remote that you wish to connect to is selected 
in the drop-down box (a). Then Click the "Connect" button (b). 
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4. At the "Patient Information" window either enter the necessary details of your 
patient or select a recent patient from the "Recent Data Entries" drop-down box. 
Then click the "OK" button to initiate the Bluetooth connection. 

 

5. Within a few seconds you will see the "Wireless Remote Connected" indicator at 
the bottom right turn green and waveforms may be traversing the screen. 
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3 Description of Monitors 
Currently Vmed Technology sells 3 wireless monitoring products that are designed to 
communicate with the PC-Display software. See each of the sections below for more 
information. 

 

3.1 PC-VetGard+ Wireless Surgical Monitor 

 

The PC-VetGard+ is a multi-parameter surgical monitor capable of monitoring and 
displaying ECG, heart rate, SpO2, respiration (from ECG or mainstream gas sensors), 
temperature, non-invasive blood pressure (systolic, diastolic and MAP), CO2, O2 and five 
anesthetic agents.  The PC-VetGard+ is modular, meaning that in addition to the basic 
unit (which includes ECG, temperature and SpO2) NIBP and gas sensors may be added 
as well.  Digital information, real-time waveforms and trending are displayed through a 
wireless link on a Windows based computer monitor. This monitoring data may also be 
recorded for later review. 
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3.1.1 PC-VetGard+ PC-Display Screen  
The screen below represents the display of the most complete PC-VetGard+ including 
O2 and anesthetic agent information. Several upper toolbar icons are duplicated on the 
PC-VetGard+ remote’s keypad making them accessible from the patients’ side. 
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3.2 PC-VetChek ECG Screening and Recovery 
Monitor 

 

The PC-VetChek includes ECG leg clips, an ECG chest sensor and a temperature probe. 
Commands can be activated from the remote’s keypad or the PC-Display upper toolbar 
on the computer. PC-Display toolbar icons and selector buttons on the PC-VetChek are 
active only if a wireless connection between the PC-VetChek and the computer is 
established. The PC-VetChek is designed to control some computer and ECG functions 
from the remote.  Some commands, including the print command, can be activated from 
the remote keypad, however data that must be entered with a keyboard such as clinic 
and patient information cannot be entered from the remote keypad.  The PC-VetChek can 
track ECG heart rates up to 800 BPM. 

 

Power is supplied by two AA batteries.  Batteries will last for about 42 hours of continuous 
use. Battery life increases markedly by substituting long-life type AA batteries.  
Rechargeable AA batteries may also be used however a charger is not available through 
Vmed. Refer to the PC-VetChek user’s manual for a complete description and use of the 
PC-Display software and PC-VetChek hardware. 
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3.2.1 PC-VetChek PC-Display Screen 
The computer screen displays digital heart rate, respiration rate (from ECG) and 
temperature. Note the “R” wave markers and the respiration waveform.  Temperature is 
available from the temperature probe (included) or from optional ECG and temperature 
esophageal probes available in three sizes. Several upper toolbar icons are duplicated 
on the PC-VetChek remote’s keypad allowing control from the patients’ side.  
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3.3 BP-AccuGard™ Blood Pressure Monitor 

 

The BP-AccuGard is a digital oscillometric blood pressure monitor optimized for small 
animals. Oscillometric devices measure the oscillation of the vessel wall as the cuff is 
deflated. The BP-AccuGard uses sophisticated algorithms to calculate the blood pressure 
measurements from these oscillations based on the pressure in the cuff. While all 
oscillometric devices have limitations, especially with patient movement and the relatively 
small size of arteries in small animals, the BP-AccuGard software is successful in 
significantly reducing motion artifacts, resulting in fast, accurate measurements.  Accurate 
measurements have been obtained on patients as small as 1.5 kg under anesthesia.   

The BP-AccuGard includes manual and automatic modes for diagnostic and surgical 
applications. In manual mode, the measurement cycle is started each time a 
measurement is desired. Automatic mode allows repeated measurements taken at user 
defined intervals. Use as a stand-alone blood pressure monitor or use the PC-Display 
software to display measurements, real-time blood pressure waveforms and a trend 
graph on your computer screen. 
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3.3.1 BP-AccuGard PC-Display Screen 
The BP-AccuGard, when linked to PC-Display, displays real time waveforms for the cuff 
inflation cycle and oscillometric pressure waveforms.  Refer to the BP-AccuGard user’s 
manual for a complete description of the PC-Display application screen. Numeric 
information displayed includes the average measured pulse rate, systolic, diastolic and 
mean arterial pressures.   

NOTE:  
Non-applicable toolbar icons are grayed out. 
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3.3.2 Discontinued Monitors 
Vmed has discontinued two older monitors but still supports both.  The PC-Vet ECG 
monitor and the PC-VetGard(1) ECG/SpO2 monitor are no longer manufactured.   

 

 

   

PC-Vet                      PC-VetGard(1) 

 

Later versions of the PC-Vet ECG monitor are compatible with PC-Display, however 
earlier versions may require the original application software called “PC-Vet” which has 
fewer capabilities.  Owners of the PC-Vet can return the device to Vmed to be updated 
and made compatible with PC-Display.  The original PC-Vet software can be downloaded 
from www.vmedtechnology.com (you may need to contact customer support for 
assistance).  The VetGard(1) is fully compatible with PC-Display. 

For questions regarding compatibility, telephone Vmed customer support at 800-296-
7763.  
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4 Operating Instructions 
 

4.1 Patient Information 
After first selecting the Vmed wireless remote to connect to, you will be presented with a 
window called “Patient Information” as shown below. This window allows you to enter in 
the patient and client information for the patient you are about to monitor so that it will be 
included in the recorded monitoring data.  

 

However, you are not obligated to enter all of the patient data at the beginning of a 
connection. You may wish to edit the patient information after connecting to your Vmed 
remote, but it is best done before that recording ends. To edit the patient information later, 
either select the “Tools” menu followed by “Edit Patient Information…” or click on the 
Patient Information button on the upper tool bar (see section 4.4). 

If you choose not to enter any data initially then PC-Display will automatically record the 
“Patient Name/ID” field as a set of numbers corresponding to today’s date. This 
information may also be edited later in the final recorded episode file through the Vmed 
Interpreter or Reviewer programs. Vmed recommends at least entering a patient’s name 
or ID in the “Patient Name” box prior to monitoring in order to make it easier to locate later 
on. 

Additionally, if you have recently monitored a patient and provided patient information to 
PC-Display then you may be able to find that patient listed in the drop-down list below 
“Recent Data Entries.” Selecting an item from this list will fill out all of the fields in the 
Patient Information window according to what was saved for that entry. 
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Once you click the “OK” button then the wireless connection to your Vmed remote will 
commence. Therefore, make sure that your Vmed remote is turned on and in range 
when you are ready to complete the Patient Information window. 

 

4.2 Screen Elements 
Below is an image of the PC-Display monitoring screen with each area numbered. 
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The numbers in the previous image correspond to the items listed below. And each sub-
section afterward corresponds to these numbers as well. 

1. Title Bar 
2. Menu Bar 
3. Toolbar 
4. Parameter Boxes 
5. Status Area 
6. Waveform Boxes 
7. Connection Indicator 

 

4.2.1 Title Bar 
The title bar is standard among most windows within the Microsoft Windows operating 
system. In this case, it not only shows the name of this software, PC-Display, but also 
shows the text that was entered for the patient’s name followed by the type of Vmed 
wireless remote that is connected. 

 

4.2.2 Menu Bar 
The menu bar is also a mainstay of the operating system and allows easy access to 
multiple functions within the software from one of four top-level menus: File, View, Tools 
and Help. 

 

4.2.3 Toolbar 
The toolbar is a row of buttons at the top of the screen, each with its own individual icon 
to indicate its purpose. Each button performs a common function within the PC-Display 
software. More detail on each one is given in section 4.4. 

 

4.2.4 Parameter Boxes 
The parameter boxes each display modality specific data, usually numeric, that allows 
the user to monitor the vital signs of their patient from their Vmed wireless monitor. Each 
parameter box shows the primary vitals number(s) in addition to the current alarm limits 
for that value (if Alarm monitoring is enabled).  

Some of them, such as the Heart Rate parameter box, also show additional information 
such as sweep speed and gain of the ECG as well as an icon timed with the heart rate 
itself. The BP parameter box also shows an animated icon which indicates which stage 
of the non-invasive blood pressure measurement is currently active (a red ‘x’ for disabled, 
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concentric circles for ‘measuring’ and a stopwatch for the interval between automatic 
measurements). 

Each parameter box also has its own title bar which shows the kind of parameter and its 
current unit in parenthesis. And, in the case of the HR parameter box, it will show the 
source of the heart rate value (ECG, SpO2 or NIBP). The BP parameter box will also 
show the cuff size that is currently selected. 

 

4.2.5 Status Area 
The status area shows the current date and time from the computer, the currently selected 
species and the battery charge indicator of the currently connected wireless remote (the 
displayed battery charge is only shown in increments of 25%). And, if the monitoring 
session is currently recording then the status area will also display which kind of recording 
is active and a running timer since that recording last began (see section 4.6 for more 
information about recording). 

 

4.2.6 Waveform Boxes 
The waveform boxes show a waveform that traces across the screen depicting rapidly 
changing vital signs values. The three types that PC-Display can show are Lead-II ECG, 
a plethysmograph (from SpO2) and a capnograph (from CO2; or a simple respiration 
curve if from ECG), depending upon what is available from the currently connected 
monitor type. If a BP-AccuGard is connected then it will show both the oscillometric 
pressure from the cuff as well as the average cuff pressure waveforms. More information 
about speed and size of waveforms is given in section 4.3. 

 

4.2.7 Connection Indicator 
The connection indicator exists to show the wireless connection state of PC-Display. 
There are two indicators: whether a chosen wireless remote is attempting a connection 
(a yellow background with “Wireless Remote Connecting”) or has already established a 
connection (a green background with “Wireless Remote Connected”). If neither is 
displayed then PC-Display is in an idle state with respect to the wireless connection 
process. In other words, the connection cycle is disabled. 
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4.3 Sweep and Scale 

4.3.1 Sweep Speed 
Sweep moves the waveform across the display from left to right at the selected sweep 
speed (chart speed).  Default sweep speed is 25 mm/sec, which is preferred for surgical 
monitoring.  A sweep speed of 50 mm/sec should be used for diagnostic ECGs. 
Increasing the sweep speed is analogous to zooming in on the horizontal scale.  

 

Time is measured on the horizontal scale with hash marks at the bottom of each waveform 
box on both the display and print report. These denote each second. 

 

The ECG waveform color is magenta if the signal is “Leads Off” or has poor electrode-
patient contact. It is green with good electrode-patient contact, or “Leads On”.  If the 
waveform is magenta, an ECG complex may appear; however, a heart rate will not be 
displayed.  

 

4.3.2 Vertical Scale (Gain) 
The vertical scale of the display and the print report measures signal amplitude.  When 
gain is set at 1, the signal amplitude of 1mV has a vertical scale deflection of 10 mm by 
convention. A 1mV reference mark appears on the display and print report at the left side 
of each waveform box. Vertical scale deflection increases by a multiple of the gain and 
the 1mV reference mark also increases proportionately. Therefore, increasing the gain is 
analogous to zooming in on the vertical scale. 

 

NOTE:  
Grid spacing does not change with the gain setting.  Use the amplitude 
reference marker (1mV) to estimate the amplitude of ECG signals on 
the screen.  
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4.4 Toolbar Buttons and Functions 
 

 

The PC-Display Toolbar provides quick, easy access to several common functions within 
the PC-Display software.  The following table will describe each button and its associated 
function within PC-Display. 

 

 

The Grid Enable button is a toggle button that will 
overlay a wire-frame grid over both the ECG and CO2 
waveforms (when connected to a BP-AccuGard this will 
put a grid over both the cuff and oscillometric 
waveforms).  The height of each rectangle within the 
grid is directly associated with the vertical scale marker 
at the bottom left of each waveform box. 
 

 

The Sweep Rate cycle button will allow the user to 
change the sweep rate of the ECG and SpO2 
waveforms by cycling through each of the available 
rates:  25 mm/sec, 50 mm/sec, 100 mm/sec or 200 
mm/sec.  The current sweep rate will be denoted at the 
bottom of the ECG parameter box. 
 

 

The ECG Gain cycle button will allow the user to 
change the gain (vertical scale factor) of the ECG 
waveform by cycling through each of the available gain 
settings:  x0.5, x1.0, x2.0, x3.0 and x4.0.  The current 
ECG gain setting will be denoted in parenthesis at the 
bottom of the ECG parameter box. 
 

 

The R-wave enable button is a toggle button that, if 
enabled, will place a white inverted triangle (R-wave 
marker) above each recognized beat in the ECG 
waveform area.  This can be useful for determining 
whether the monitor is double-counting beats. 
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The ECG Tone enable button is a toggle button that will 
produce a tone whenever a heartbeat is encountered 
during the monitoring session – from either ECG or 
SpO2, depending upon which it is set to.  It will usually 
default to the ECG, but if no Leads-On ECG signal 
exists then it will revert to SpO2 for both the heart rate 
and beat tone. 
 

 

The Waveform Selection button will bring up another 
window that gives the user the choice of which 
waveforms to display in the main monitoring screen at 
that time.  For all available remotes it will always include 
the ECG waveform, but may also give the option for the 
SpO2, CO2 and O2 waveforms, depending upon what 
is available with the current remote. 

 

The Current Configuration button allows quick access 
to the configuration of the current session.  Any values 
that are modified here will return to the default values 
upon exiting PC-Display.  (see section 5.2) 
 

 

The Silence Alarms button is a toggle button whose 
factory default is to be enabled, meaning that any 
tripped alarm will sound the alarm tone.  When disabled 
the alarm sound will cease regardless of how many 
parameters are out of range. 
 

 

The Monitor Alarms button is also a toggle button that 
is enabled by factory default.  When enabled, this will 
show the alarm limits beside each digital value and 
provide a recorded alarm event and the audible alarm 
tone if those options are enabled as well.  However, 
even if those options are still enabled, they will not 
activate if this button is disabled. 
 

 

The Trend Graph button, when clicked, will open the 
Trend Graph window to show the values that are 
monitored for trends.  Each different remote type will 
show trend information for different parameters, based 
upon that particular remote type. 
 

 

The Record Episode button is a toggle button that is 
by factory default enabled.  When enabled, this button 
will record a patient episode file.  When disabled then 
no parameters will be recorded unless the Print function 
is taken.  See a later section of this chapter for more 
details. 
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The Patient Information button will allow the user to 
change the patient information for the current recording 
session by opening the Patient Information window.  
This is the same window that appears when connecting 
to the wireless remote. 
 

 

The Print button will allow the user to print either 1 or 2 
pages of ECG waveform information along with any 
patient information that has already been input so far in 
this monitoring session.  Each time this button is 
pressed it will include one page’s worth of ECG 
waveform prior to the point in time when the button was 
pressed.  See a later section of this chapter for more 
details.  This option is not available for the BP-
AccuGard. 
 

 

The Review Episode button allows the user to open 
any of the recorded patient episode files that have been 
recorded in the current monitoring session directly into 
the Vmed reviewing software selected within the 
configuration window.  
 

 

The Stop/Start button is a toggle button that by default 
is disabled (play).  When it is clicked/enabled it will 
freeze the waveforms on the screen (stop) for easier 
viewing.  To disable it again simply click it once more 
(start). Clicking on this button will not pause any 
recorded measurements that are in progress – only 
what is viewed on the screen. 
 

 

The BP Measurement button is also a toggle button 
that is disabled by default.  Once clicked to enable, it 
will initiate the automatic measurement process once a 
cuff size has been selected from the resulting window.  
This option is only available for remotes with blood 
pressure capability (PC-VetGard+ and BP-AccuGard). 
 

 

The Marker button allows one to quickly record a vital 
signs event (“marker” event) if an episode is being 
recorded.   
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The Info button allows quick access to version 
information for PC-Display as well as any connected 
wireless remote.  This button may only be necessary 
when speaking to a support representative. 
 

 

The Gas Selection icon allows the user to select the 
Primary and Secondary anesthetic agents to monitor if 
a capable gas sensor is connected to the PC-VetGard+. 
 

 

It is important to note that some of these Toolbar icons with toggle functionality have either 
a green check mark or a red ‘x’ at the base of the icon as shown below. 

 

This is to denote whether the function this icon represents is currently enabled or disabled, 
respectively.  Additionally, the buttons that show they are enabled will usually also have 
a recessed look to make this concept clearer. 

 

 

4.5 Alarms and Sounds 
PC-Display has several sounds that are useful for monitoring a patient while you are not 
always looking at the screen.  There are primarily 3 different kinds of sounds within PC-
Display that help to serve this purpose. 

 

4.5.1 Alarm Tone 
The alarm tone is a continuous sound of two rapidly alternating tones for as long as its 
function is active.  The alarm tone can only be active if the following conditions are met: 

 

1. The Monitor Alarms button is enabled 
2. The Silence Alarms button is enabled (disabled would mean that the alarm is 

silenced) 
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3. An alarm is tripped (one of the parameters with an alarm limit has exceeded that 
limit) 

 

If a parameter’s alarm limit has been exceeded while the alarms are enabled then for as 
long as this parameter is out of its normal range the alarm tone will be active (it will 
continuously sound).  However, if the user disables the Silence Alarm button and then re-
enables that button then the alarm tone will no longer be active until that parameter 
changes to another value that is out of range. 

 

Additionally, if a parameter is out of range then the same alarm tone will sound no matter 
which parameter is out of range.  To give the user a visual cue as to which parameter has 
gone out of range, the numbered alarm limit next to each vital signs parameter will change 
to black digits on a red background. 

 

 

4.5.2 Heart Rate Tone 
For each remote type that produces a heart rate or pulse rate from ECG or SpO2, PC-
Display will provide a heart rate tone consistent with the current heart rate or pulse rate 
shown.  If the remote in use has a “Leads On” ECG signal (green tracing) then the heart 
rate and its associated tone will come from the ECG measurement.  However, in the PC-
VetGard(1) and PC-VetGard+ remotes where SpO2 can be used, the pulse rate will 
default to what is measured from SpO2 and the tone will change accordingly.  The heart 
rate tone can easily be enabled or disabled from the ECG Tone Enable button of the 
toolbar. 

 

There are two kinds of heart rate tones: from ECG and from SpO2.  These tones are 
different in order to provide the user an audible cue that the heart rate is coming from one 
source over another.  This can be helpful if, for example, the heart rate was coming from 
ECG and then suddenly switched to SpO2.  The user would take note that the most 
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probable reason is that the ECG is now “Leads Off,” which would prompt the user to 
investigate and correct this sooner rather than had no audible cue alerted them to this. 

 

4.5.3 Breath Tone 
For the PC-VetGard+ with a gas probe connected, PC-Display also provides a breath 
tone each time the patient takes a breath.  This tone is altogether different from the heart 
rate or alarm tones in order to give the user yet another audible cue to one of the patient’s 
vital signs – in this case, the respiration rate.  This tone will sound only if enabled in the 
Configuration window under the CO2 tab. 

 

In addition, PC-Display now makes 4 sets of tones available for each monitoring session.  
Each set is referred to as a profile.  Each profile includes two heart rate tones (ECG and 
SpO2) and a breath tone.  These profiles exist for the purpose of differentiating which 
remote and patient each sound is coming from if more than one remote is being used in 
the same location or by the same computer. 

 

4.6 Recording Monitoring Information 
The default setting for recording information through PC-Display varies with each monitor.  
In general, “Continuous Recording waveforms; Periodic Vital Signs” is the default setting 
for the PC-VetGard+, PC-VetGard(1), PC-VetChek and the PC-Vet.  Waveforms and vital 
signs are recorded in this mode.  “Periodic Vital Signs” is the default setting for the BP-
AccuGard.  The “Periodic Vital Signs” mode will record vital signs at the interval selected 
as well as vital signs when an alarm is tripped or a marker or print command are initiated.   

 

Unless “Auto Save” is checked on the Default Configuration screen, manually pressing 
the Record Episode button on the “Tools” selection on the PC-Display toolbar will initiate 
the recording command.  Clicking once on this button will place a checkmark in the bottom 
right corner of the button itself to show that it is enabled.  Clicking it again will disable this 
recording mode and close the episode file that was just recorded. 
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If “Auto Save” is checked, recording will begin automatically upon connection to the PC-
Display and a check mark will appear within the Record Episode button on the upper tool 
bar.   

 

NOTE:  
The Record Episode button should not be disabled until the 
monitoring episode is complete.   

 

The Review Episode icon is enabled once the Record Episode button has been toggled 
off.  The saved file can be opened by clicking the yellow icon on the remote’s keypad or 
the PC-Display toolbar and selecting the desired episode. 

 

4.7 Printing 
Printing a waveform report can be done from the PC-Display toolbar or the remote’s 
keypad (if connected to the computer), however only the waveform report will be printed 
by this method.  To obtain a complete print report, the report must be printed from either 
the Vmed ECG Reviewer or ECG Interpreter program. 

 

TO PRINT A WAVEFORM REPORT 

1. From the remote keypad:  Press the Print key, or… 
From the PC-Display upper tool bar:  Click the printer icon, or… 
From the “File” menu: choose Print. 

2. Select “Scale to fit” or “shrink to fit” on the printer setup dialog box. 

 

NOTE:  
A color printer is required to reproduce the colored grid.  Files may 
also be printed to PDF using a print-to-PDF printer driver.  
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PC-Display offers 2 choices for printing:  1 page or 2 pages.  Each page includes 600 
millimeters (200 per line) of ECG waveform data.  This means that when the user chooses 
the Print option, then the printed page will include a waveform of previously recorded data 
from the time the Print option was chosen.  Each page will have the number of seconds 
of waveform according to the current ECG sweep rate at the time of printing.  The 
following table will describe this further. 

 

Selected Sweep Rate Waveform Seconds/Page 
25 mm/sec 24 
50 mm/sec 12 

100 mm/sec 6 
200 mm/sec 3 

 

Additionally, if using the PC-VetGard+ with CO2 then the printout will also include the 
CO2 waveform just below the ECG waveform.  

 

An example of a sample waveform print report follows. 
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Sample print report 
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4.8 Keyboard Shortcuts 
PC-Display has several keystroke combinations that can be used to quickly access 
certain functions using the computer’s keyboard. Most of these keystrokes involve a 
combination of keys being pressed at the same time.  For instance, “Alt + H” denotes that 
the “Alt” key and the “H” key should be pressed at the same time to achieve the desired 
results.  Likewise, “Ctrl” denotes the “Control” key. 

 

Keystroke Action Description 

Alt + C Connect Wireless Remote 
Toggles the wireless connection process. This can 
initiate the process, halt it or disconnect from an 
already connected remote.  

Ctrl + I Edit Patient Information 

Opens the window allowing the user to edit the 
current patient’s name or ID, client name, species, 
breed, age, sex and weight.  If the session is being 
recorded then this recorded episode will reflect any 
changed values. 

Ctrl + N New Patient 

Opens the window allowing the user to input the 
next patient’s name or ID, client name, species, 
breed, age, sex and weight.  If the current session 
is already recording this will end it begin a new 
episode. 

Ctrl + P Print 

Opens the print dialog window allowing the user to 
print the last 30 seconds of the current ECG strip 
(this same strip will be recorded into an episode as 
well). 

Ctrl + G Toggle Grid 
Enable/Disable the grid behind the ECG 
waveforms. 

Ctrl + M Toggle R-Wave Marker 
Enable/Disable the triangular R-Wave markers that 
appear above each detected R-Wave of the ECG 
waveform. 

Ctrl + T Open Trend Graph Opens the Trend Graph window. 

Alt + S Cycle ECG Sweep Speed 
Cycles through the 4 sweep speeds for the ECG 
and SpO2 waveforms. 

Alt + G Cycle ECG Gain 
Cycles through 5 gain settings for the ECG 
waveform. 

Ctrl + E Edit Current Configuration 

Opens the Current Configuration window allowing 
the user to edit many of the parameters of PC-
Display’s current session without disconnecting the 
remote. 

Ctrl + Q Toggle QRS Tone Enable/Disable the heart rate tone. 

Ctrl + A Toggle Alarm Tones 
Enable/Disable the tones made when an alarm 
limit has been exceeded.  This can essentially act 
as a “silence alarm” feature. 

Alt + A Toggle Alarms Enable/Disable the alarm limits for all values. 

Alt + R Review Stored Episode 
If a complete episode has been recorded in the 
current session then this will open the “Wireless 
Remote Review Episode” window. 
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Ctrl + R Toggle Recording 
Enable/Disable the recording of patient data to a 
stored episode. 

Alt + P Stop/Start 
Enable/Disable the progression of waveforms on 
the screen (similar to freezing or unfreezing the 
current display). 

Alt + M Mark Event 

Places an orange triangular mark at that moment 
on the ECG waveform for later reference.  
Additionally, if an episode is not already being 
recorded this will record a brief episode with the 
mark listed as an event. 

Ctrl + H About PC-Display and Remote 

Opens the About window for PC-Display. If a 
remote is connected at the time then this window 
will also display the built-in parameters of this 
remote. 

? View Manual 
Opens an online version of the user’s manual in a 
web browser. 
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5 Configuration 
The PC-Display software has two types of configurable settings. The first type is the 
Default Configuration where all the various options are set. The Default Configuration 
settings are what determine the settings each time the PC-Display software is opened. 
The second is the Current Configuration, which is derived from the Default Configuration. 
However, it is limited to the currently connected Vmed wireless monitor and its available 
sensors as well as the currently selected patient type. The Current Configuration can be 
edited while monitoring whereas the Default Configuration can only be edited while not 
connected to a Vmed wireless remote.  

 

5.1 Default Configuration 
The Default Configuration includes many settings for multiple modalities, sensors and 
patient types. The Default Configuration can only be reached when PC-Display is not 
already connected or attempting to establish a wireless connection to a remote. To open 
it, follow the below steps. 

 

1. Double-click the PC-Display icon on your desktop to open it. 

 

2. Click the “Cancel” button on the “Select Wireless Remote Connection” window 
and continue to step 4. 

 

40 

If instead you see the “Vmed Remote Switcher” window then click “Connect” and 
continue to step 3. 

 

 

3. Click the “File” menu and confirm that there is no check mark next to the 
“Connect Wireless Remote…” item. If there is then click this item to disable the 
wireless connection process. 
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4. Click the “Tools” menu followed by “Edit Default Configuration…” and the Default 
Configuration window (titled as “Product Configuration”) will open: 

 

Some selections in the Default Configuration menu apply only to certain wireless remote 
types.  Each selection listing below will show which type of wireless remote this feature 
applies to by including any of the following images next to it. 

PC-Vet 

 

PC-VetGard(1) 

 

PC-VetGard+ 

 

PC-VetChek 

 

BP-AccuGard 
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Because there are so many different options listed in the Default Configuration, they have 
been separated into tabs for clarity and focus. Each section below represents one of these 
tabs. See each one for the individual options listed within them. 

 

5.1.1 General Tab 
Specify COM Port Number 

 

The “Specify Com Port Number” box should not be checked in most 
situations.  The appropriate COM port number should be entered here only 
in situations such as when an internal Bluetooth adapter is used with the 
monitoring computer (see section 2.1.1). Please call Vmed for support if you 
are unsure whether you need this option. 

FACTORY DEFAULT: UNCHECKED 

 

Check For Updates 

 

If a checkmark is in the box next to “Check for Updates” then PC-Display 
will periodically check to see if a later version has been released.  If an 
update is available PC-Display present you with the option to download it. 
There is also an option under the Help menu that will allow you to manually 
perform this check. NOTE: Requires an active Internet connection to the 
computer where PC-Display resides.  

FACTORY DEFAULT: CHECKED 

 

Species 

 

Select the most common species of patient that is seen.  This will be the 
default for each new patient.  

FACTORY DEFAULT:  CANINE 
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Maximum ECG Waveforms 

 

Choose the maximum number of continuous Lead II ECG waveforms that 
you wish to appear on the screen (from 1-4).  How many waveforms actually 
appear is equal to this number minus the number of other waveforms (SpO2, 
Respiration/CO2, O2) that are also currently available and enabled.   

FACTORY DEFAULT:  4 

 

Weight Unit 

 

Set the default unit of weight measurement to appear in the Patient 
Information screen.  The available options are “kgs”, “lbs”, “g” and “oz”.  

FACTORY DEFAULT:  “LBS” 

 

Print Report 

 

Choose the desired number of pages for the print report.  Select two pages 
to display waveforms on both.  

FACTORY DEFAULT:  1 PAGE 

 

Alarm Settings: Sound Alarm Tones 

 

If checked, this will allow the alarm tone to sound whenever an alarm is 
tripped.  

FACTORY DEFAULT: CHECKED 
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Alarm Settings: Display Alarms 

 

If checked, all the designated alarm limits will be evaluated for an alarm 
event and the alarm tone (if enabled).  If left unchecked, no alarm events 
will occur or alarm tones will sound.  

FACTORY DEFAULT: CHECKED 

 

Alarm Settings: Tone and Background Color Profile 

 

If you are connecting to multiple wireless remotes on the same computer 
then you can choose individual profiles for the Alarm Beats and Tones to 
more easily differentiate the sounds and monitoring screens from each 
remote.  Each of the four profiles has a unique sound for each of the 
following:  heart beat from ECG, heart beat from SpO2 and breath tone.  
This setting will be the default each time PC-Display is started.  Additionally, 
each profile also as a background color for the waveform areas associated 
with it as well.  Profiles 0–3 use the following background colors, 
respectively: black, navy, forest green and plum.  To select a different profile 
for each remote simply open the Current Configuration window on the PC-
Display upper tool bar after this remote has connected to PC-Display.  

FACTORY DEFAULT: 0 

 

Alarm Settings: Alarm Tone Snooze 

 

Set an automatic “snooze” on the alarm tone whenever it is silenced so that 
it will re-enable itself once the preset time has elapsed. The time options 
are 10 seconds, 30 seconds, 1 minute, 5 minutes, 10 minutes and 30 
minutes. To turn off the alarm tones simply click the alarm tone toolbar 
button once more.  

FACTORY DEFAULT: OFF 
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ECG Sweep Rate 

 

Select the desired sweep rate (Chart speed) as desired.  Use a sweep rate 
of 50 mm/sec for diagnostics and 25 mm/sec for surgery.  This applies only 
to ECG and SpO2 waveforms.  

FACTORY DEFAULT: 25 MM/SEC 

 

RR/CO2/O2 Sweep Rate 

 

Select the desired sweep rate for the respiration, CO2 and O2 waveform 
areas.  

FACTORY DEFAULT: 12.5 MM/SEC 

 

Episode Reviewer 

 

Select which Vmed software will open recorded episodes directly from the 
PC-Display toolbar:  ECG Reviewer or ECG Interpreter.  This depends upon 
which is installed.  If neither is installed then this option is grayed out or 
invisible.  

FACTORY DEFAULT: ECG REVIEWER 

 

Automatic Trend Graph Display 

 

Choose the time interval of how often the trend graph will display 
automatically and momentarily throughout the procedure.  

FACTORY DEFAULT:  OFF 
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ECG Features: R-Wave Markers 

 

Checking this will display the white inverted triangles that appear above 
each beat in the ECG waveform area.  Markers are helpful in detecting 
double-counting of beats.  

FACTORY DEFAULT:  CHECKED 

 

ECG Features: 5mm Reference Grid 

 

Checking this will display a reference grid behind the ECG and 
respiration/CO2/O2 waveform areas.  The vertical scale of each rectangle 
in this grid is determined by the gain marker to the left of each waveform 
window, while the horizontal scale of each rectangle is always 5 mm.  

FACTORY DEFAULT:  UNCHECKED 

 

ECG Features: QRS Tone 

 

Checking this will enable a specific tone to sound according to the heart 
rate. The tone will be different depending upon whether the heart rate is 
retrieved from ECG or from SpO2.  Each of these tones will be different 
within each Beat Tone Profile.  

FACTORY DEFAULT:  CHECKED 

 

ECG Features: Heart Rates > 400 BPM 

 

PC-Display has the ability to calculate heart rates greater than 400 BPM for 
exotic animals. For veterinary use on canine/feline patients leave the “Heart 
Rates >400 BPM box unchecked.  

FACTORY DEFAULT:  UNCHECKED 
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Waveforms 

 

Select which of the three waveforms (other than ECG) you would prefer to 
have automatically displayed upon startup. The BP-AccuGard makes use 
of the RR and O2 waveforms by default and cannot modify these.  

FACTORY DEFAULT:  SPO2, RR CHECKED; O2 UNCHECKED 

 

ECG Notch Filter 

 

The default ECG notch filter is used to filter AC line interference. For 
Domestic use (North America) choose 60 Hz. For international use choose 
50 Hz.  

FACTORY DEFAULT:  60 HZ 

 

ECG Low Pass Filter 

 

Some instances of noise on the ECG signal can be reduced by selecting 
one of these filter types.  

FACTORY DEFAULT:  LOW 

 

Patient Episode Recording Mode: AutoSave 

 

Auto Save is the default setting.  A check mark in the “Auto Save” box 
enables automatic saving of all patient data upon connection to a remote 
device without manually pressing the green record button on the PC-Display 
upper tool bar.  

 

Selecting Auto Save enables the default recording mode selection: either 
“Continuous Waveforms; Periodic Vital Signs” or “Periodic Vital Signs Only”.  
Continuous Recording mode will save both ECG and/or CO2 waveforms 
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and vital signs.  Selecting Periodic Vital Signs Only will record vital signs 
and monitoring events without any waveform data.  

FACTORY DEFAULT:  CHECKED; CONTINUOUS RECORDING mode.  

 

NOTE: 
The BP-AccuGard cannot record any waveform data no matter which 
option is selected. 

 

The following table shows how to manage what is recorded. 

Configuration Options Operation Actions 
 

Data Recorded 

Auto 
Save 

Vital 
Signs 
Only 

Continuous 
Recording 

Record 
Button 

Print 
Command 

OFF X X OFF NO Nothing 

OFF X X OFF YES 
24 sec. of ECG waveform and any events 

during that time, including Print event 

OFF X X ON NO Waveform(s) and Events 

OFF X X ON YES 
24 sec. of ECG waveform and any events 

during that time, including Print event 

ON ON OFF OFF NO Nothing 

ON ON OFF OFF YES 
24 sec. of ECG waveform and any events 

during that time, including Print event 

ON ON OFF ON NO Events Only 

ON ON OFF ON YES Events Only (without print event) 

ON OFF ON OFF NO Nothing 

ON OFF ON OFF YES 
24 sec. of ECG waveform and any events 

during that time, including Print event 

ON OFF ON ON NO Waveform(s) and Events 

ON OFF ON ON YES 
24 sec. of ECG waveform and any events 

during that time, including Print event 
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Patient Episode Recording Mode: Single Instance 

 

Checking this will make it possible for only one instance of PC-Display to 
be open at a time on this computer.  Selecting Multiple Instances allows 
multiple wireless remotes to be connected to this computer simultaneously.  

FACTORY DEFAULT:  UNCHECKED 

 

Patient Episode Recording Mode: CO2 Save 

 

Checking this will allow the CO2 waveform, or capnograph, to be saved in 
addition to the ECG waveform whenever Continuous Recording is selected.  

FACTORY DEFAULT: CHECKED 

 

Patient Episode Recording Mode: Save All BP Measurements 

 

Checking this will cause PC-Display to save the vital signs each time a 
blood pressure measurement is complete.  This will show up as a “vitals” 
event.  

FACTORY DEFAULT: CHECKED 

 

Patient Episode Recording Mode: Vital Signs Logging Interval 

 

This selection determines how often vital signs are automatically recorded 
to provide a record of the surgery.  Intervals of 1, 3, 5, 10 and 15 minutes 
are possible as long as patient recording is enabled.  A time reference 
stamp is also recorded.  

FACTORY DEFAULT:  5 MINUTES 
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Patient Episode Recording Mode: Patient Episode Directory 

 

This is the location where your recorded patient data files (referred to as 
“patient episodes”) are stored by PC-Display.  Click the “Select Directory…” 
button if you wish to change this location.  

FACTORY DEFAULT:   

<LOCAL USER DIRECTORY>\DOCUMENTS\VMED_PATIENT_EPISODES 

 

5.1.2 ECG, Temperature Tab 

 

Heart Rate and Temperature Alarm Limits 

 

“High” and “Low” limits show the default values at which the alarm will be 
triggered for both heart rate and temperature.  Additionally, each limit can 
be enabled or disabled individually. Note that the Heart Rate (“HR”) limits 
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here correspond to the heart rate given by ECG, SpO2 and NIBP. The 
below table shows the FACTORY DEFAULTS for these values: 

Species HR High HR Low Temp* High Temp* Low 
Canine 140 80 103.0 95.0 
Feline 200 100 103.0 95.0 
Equine 160 40 103.0 95.0 
Other 240 40 103.0 95.0 

* Temperature values here are shown in Fahrenheit 

 

ECG Gain 

 

The default ECG gain can now be set per species type so that this gain 
value will automatically be active when a patient of that species is selected 
for monitoring.  

FACTORY DEFAULT:  x1.0 (10mm/1mV) [for each species] 

 

Temperature Units 

 

The default temperature units can be selected here between Fahrenheit and 
Celsius.  Alarm limits will automatically adjust to the temperature scale.  

FACTORY DEFAULT:  FAHRENHEIT 

 

52 

5.1.3 SpO2, Respiration Tab 

 

SpO2 Alarm Limits 

 

The “High” and “Low” limits here show the default values at which the 
alarm will be triggered for SpO2 on each species type.  Each limit can be 
enabled or disabled individually.  The below table shows the FACTORY 
DEFAULTS for these values: 

 

 

Species SpO2 High SpO2 Low 
Canine 100 92 
Feline 100 92 
Equine 100 92 
Other 100 92 
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Respiration Alarm Limits 

 

The “High” and “Low” limits here show the default values at which the 
alarm will be triggered for “RR” (respiration) on each species type.  
Additionally, each limit can be enabled or disabled individually.  The below 
table shows the FACTORY DEFAULTS for these values: 

 

Species RR High RR Low 
Canine 120 6 
Feline 120 6 
Equine 120 6 
Other 120 6 

 

 

5.1.4 Blood Pressure Tab 
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Blood Pressure Alarm Limits 

 

The “High” and “Low” limits here show the default values at which the alarm 
will be triggered for the blood pressure values on each species type.  Each 
limit can be enabled or disabled individually.  The below table shows the 
FACTORY DEFAULTS for these values: 

 

Species Cuff Size Sys High Sys Low Dia High Dia Low MAP High MAP Low 
Canine NEONATE 3 190 80 100 50 120 60 
Feline NEONATE 3 160 80 100 50 120 60 
Equine NEONATE 3 160 80 100 50 120 60 
Other NEONATE 3 160 80 100 50 120 60 

 

Measurement Time Interval 

 

Determines how often blood pressure measurements will be taken 
automatically. Intervals of 1, 2, 3, 5, 10, 15, 30 and 60 minutes are available.  

FACTORY DEFAULT:  5 MINUTES 

 

Initial Cuff Inflation Pressure 

 

This value is the initial cuff pressure peak of the cuff inflation cycle, given in 
mmHg. This pressure should be 30 mm Hg over the expected systolic 
pressure.  

FACTORY DEFAULT:  160 

Measurement Complete Tone 

 

This tone is intended to sound at the completion of each blood pressure 
measurement.  It is currently not functional.  

FACTORY DEFAULT:  CHECKED 
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5.1.5 Apnea Tab 

 

 

The “High” and “Low” apnea limits show are the default values at which the 
alarm will be triggered for when breathing stops for the time in seconds on 
each species type.  The range for this time is 20 to 60 seconds.  Each limit 
can be enabled or disabled individually.  The below table shows the 
FACTORY DEFAULTS for these values: 

Species Apnea Time Enabled 
Canine 20 sec Yes 
Feline 20 sec Yes 
Equine 20 sec Yes 
Other 20 sec Yes 
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5.1.6 CO2 Tab 

 

CO2 Alarm Limits 

 

The “High” and “Low” limits show the default values at which the alarm will 
be triggered for CO2 inspired (FiCO2) and expired (ETCO2) values on each 
species type.  Each limit can be enabled or disabled individually.  The below 
table shows the FACTORY DEFAULTS for these values: 

Species Insp. High Insp. Low Exp. High Exp. Low 
Canine 7.6 2.3 40.3 28.9 
Feline 7.6 2.3 40.3 28.9 
Equine 7.6 2.3 40.3 28.9 
Other 7.6 2.3 40.3 28.9 

 

CO2 Units 

 

The units shown in the alarm limit boxes are determined by which option is 
selected either – mmHg (Partial Pressure) or % (Volume Percent).  If you 
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enter numbers in one unit and then select the other then they will be 
automatically converted for you.  

FACTORY DEFAULT:  mmHg 

 

Enable Breath Tones 

 

If checked, this option will sound a particular tone each time a patient’s 
breath is detected by the CO2 sensor.  This tone will be different according 
to which sound profile is selected from the General tab.  

FACTORY DEFAULT:  CHECKED 

 

CO2 Waveform Full Scale 

 

The Full Scale setting will determine the highest values that can be 
displayed on the CO2 waveform graph (capnograph).  For expected expired 
CO2 values above 40 mmHg (5%) the 100 mmHg (12%) setting should be 
chosen.  

FACTORY DEFAULT:  12.5% or 100 mmHg 

 

Expected O2 Environment 

 

This setting should only be needed with gas probes that do not measure O2 
directly.  This will set the expected O2 for the environment so that the gas 
probe can calculate its measured gas concentrations appropriately.  

FACTORY DEFAULT:  70% - 100% 
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5.1.7 O2 Tab 

 

O2 Units 

 

The units shown in the alarm limit boxes are determined by which option is 
selected either – mmHg (Partial Pressure) or % (Volume Percent).  If you 
enter numbers in one unit and then select the other then they will be 
automatically converted for you.  

FACTORY DEFAULT:  % Volume 

 

O2 Alarm Limits 

 

The “High” and “Low” limits show the default values at which the alarm will 
be triggered for O2 inspired and expired values on each species type.  Each 
limit can be enabled or disabled individually.  The below table shows the 
FACTORY DEFAULTS for these values (all units are in volume percent, %): 
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Species Insp. High Insp. Low Exp. High Exp. Low 
Canine 99.9 21.0 99.9 18.0 
Feline 99.9 21.0 99.9 18.0 
Equine 99.9 21.0 99.9 18.0 
Other 99.9 21.0 99.9 18.0 

 

5.1.8 Agent Tabs 
This menu allows you to set default inspired (I) and expired (E) alarm limits for 
the anesthetic agents with which your PC-VetGard+ is equipped.  Select the tab 
that applies to your agent sensor.  These values apply to the following gas types:   
N2O, Halothane, Enflurane, Isoflurane (pictured below), Sevoflurane and 
Desflurane. 

NOTE:  
Agent units display in mmHG or percent volume (%).  Be sure to check 
“Enable Display” where it applies. 
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Agent Units 

 

The units shown in the alarm limit boxes are determined by which option is 
selected either – mmHg (Partial Pressure) or % (Volume Percent).  If you 
enter numbers in one unit and then select the other then they will be 
automatically converted for you.  

FACTORY DEFAULT:  % (Volume Percent) 

 

Agent Alarm Limits 

 

The “High” and “Low” limits show the default values at which the alarm will 
be triggered for each agent inspired and expired values on each species 
type.  Each limit can be enabled or disabled individually.  The below table 
shows the FACTORY DEFAULTS for these values (units are in volume 
percent, %): 

Agent* Insp. High Insp. Low Exp. High Exp. Low 
N2O 99.9 1.0 99.9 1.0 

Halothane 5.0 1.0 5.0 1.0 
Enflurane 5.0 1.0 5.0 1.0 
Isoflurane 5.0 1.0 5.0 1.0 

Sevoflurane 8.0 1.0 8.0 1.0 
Desflurane 18.0 1.0 18.0 1.0 

* These default values are set the same for all listed species types.  Please use 
professional judgment to determine if these values correspond with current veterinary 
practice standards for each species type. 

 

5.1.9 Practice Mgmt Software Tab 

 

Select the “Practice Mgmt Software” tab to set PC-Display to interact with certain 
practice management software. 

NOTE: 
Currently, PC-Display only interacts with AVImark practice 
management software.  Additional integrations may be added in the 
future. 
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Put a checkmark in the box next to “Auto Populate New Patient Information from 
AVImark” in order to enable the automatic population of the PC-Display patient 
information fields each time a new patient is selected within PC-Display. 
FACTORY DEFAULT: UNCHECKED 

NOTE: 
AVImark software must be open and logged in and its COM Object 
feature enabled for this function to work. Contact Vmed Support for 
setup assistance. 

 

 

5.2 Current Configuration 
When PC-Display opens it will load all the necessary settings from the defaults given in 
the Default Configuration. However, once a monitoring session as begun by connecting 
to a wireless remote you may change many of these settings for the duration of your 
monitoring session using the Current Configuration. 

Once connected to your wireless remote there are 3 ways to open the Current 
Configuration window. 

1. Click the “Current Config” button on the toolbar (see section 4.4) 
2. Click the “Tools” menu followed by “Edit Current Configuration…” 
3. Type the “Ctrl-E” shortcut on your keyboard 
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The above image shows an example of the Current Configuration window. In this case a 
PC-VetChek is connected to PC-Display. Note that only a few of the items that were 
shown on the General tab of the Default Configuration (see section 5.1) are shown here. 
Note also that a smaller number of tabs are even shown here as well. This illustrates the 
point that the Current Configuration will only show the settings that can be modified for 
the currently connected wireless monitor and selected species type. Therefore, since a 
PC-VetChek only provides the modalities of ECG, respiration and temperature only those 
tabs are available for modification.   

Additionally, any modifications to the Current Configuration settings do not persist after 
PC-Display is closed. These changes are meant to be temporary. But if you do wish them 
to be made permanent then follow these steps.  

1. Click the “File” menu and select “Connect Wireless Remote…” (at this point, 
there should be a check mark by this) and this will toggle off your wireless 
connection. 

2. Click the “Tools” menu and select “Edit Default Configuration…” 
3. Click OK to the Default Configuration and close PC-Display 

Performing these steps allows you to transfer the temporary settings from the Current 
Configuration to make them permanent in the Default Configuration. 
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5.3 Custom Species & Breeds 
Species and Breeds available in the dropdown menu of the Patient Information window 
are user customizable using the following procedure (the use of Microsoft Excel is 
recommended for best results): 

NOTE: 
The following exercise should be performed from the computer’s 
administrative user account. 

1. Verify that your computer has Microsoft Excel installed. 
2. Click on the Windows ‘File Explorer’ icon and navigate to the installation directory 

for PC-Display. For most users this will be ‘C:\Program Files (x86)\Vmed 
Technology\PC-Display’. 

3. Select the file ‘Species&Breeds.xls’ and then right click the mouse and select 
“Copy”, then right click again in the white space of the window and select “Paste” 

4. A file called ‘Copy of Species&Breeds.xls’ will be created. Right click on this new 
file and choose ‘Rename’ then rename the file to ‘CustomSpecies&Breeds.xls’. 

5. Double-click on “CustomSpecies&Breeds.xls”. Excel should open it as shown 
below: 
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6. The spreadsheet can be edited to add species and breeds as desired. The 
following restrictions apply: 
 Entry A1 must remain “Species” and B1 “Breed”. 
 The total number of characters per spreadsheet line (Species and Breed) 

must be less than 60 
 There can be no more than 25 different kinds of species 
 There can be no more than 500 breeds per species. 
 There can be no more than 2000 total entries in the spreadsheet. 
 Do not enter data in any columns except A and B 

7. Save the edited spreadsheet. 
8. Use Excel’s “Save As” feature to save the spreadsheet as tab delimited text. The 

saved filename should be “CustomSpecies&Breeds.txt” and it should be stored in 
the same PC-Display installation directory. This file is read by PC-Display to 
generate the species and breeds dropdown menus in the patient information 
dialog. 

 

5.4 Hospital Information 
The Hospital or Vet Information stores a business name, address, phone and email 
address for this business that will be used on the print reports. By default, these are left 
blank, but if you wish to add yours then follow the below steps. Some fields may be left 
blank if they do not pertain to your location. For instance, in Canada, “State” would refer 
to your territory and in other nations it may not be needed at all. 

 

These steps refer to use in the US and & Canada. 

1. Click the “Tools” menu on the upper tool bar of the PC-Display and then “Edit Vet 
Information” and the following window will appear: 
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2. Type in your vet/clinic information as above. 

NOTE: 
Your entries will be remembered each time the program is started and 
contains text that will be included on all printed reports. 

 

3. Press OK. 

NOTE: 
Refer to the instructions in section 5.5 if you wish to add your clinic 
logo to the report heading. 

 

 

5.5 Hospital Logo in Printed Reports 
The default logo provided in the ECG report printout is shown below. 

 
To customize a logo specific to your clinic, perform the following. 

NOTE: 
Make sure that you perform this from the computer’s administrative 
user account. 
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1. Click on the Windows File Explorer icon and navigate to the installation directory 
for PC-Display. For most users this will be, ‘C:\Program Files (x86)\Vmed 
Technology\PC-Display’.  A screen similar to the one below will appear: 

 

2. Select the file ‘logo’ image file and then right click the mouse and select “Copy”, 
then right click again and select “Paste”. 

 

3. A file called ‘logo - Copy’ will be created. Right click on this new file and choose 
‘Rename’ then rename the file to ‘customlogo’. 

 

4. The image in this file will now appear on the printouts from PC-Display. Edit the 
file to create your own custom logo. The following constraints must be observed. 
 The file must be named ‘customlogo.bmp’ 
 Any size image can be used, but it will be stretched or compressed to 1024 

by 512 pixels in the printout, so it’s best to use those dimensions. 
 The image must be in ‘.bmp’ format, 24-bit color.  Any photo editor can be 

used to create a custom logo. Most computers will at least have Windows 
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Paint. If you have a logo as part of the header in a Word document it can be 
cut and then pasted into Windows Paint, resized and then saved. 

 Vmed software upgrades will overwrite the original ‘logo.bmp’ file but will 
leave the ‘customlogo.bmp’ file untouched. Software upgrades should not 
affect the new logo. 

NOTE: 
The ‘Print Preview’ function in PC-Display can be used to see how the 
new logo will look on the printout. An example is shown below. 

 

Sample print report with customized clinic logo: 
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6 Support and Troubleshooting 
 

6.1 Service and Support 
If you purchased directly from Vmed: 

Phone:  800-926-9622 

Email:  info@vmedtech.com  

WEB:   https://www.vmedtechnology.com/sales-support/ 

 

6.2 Software Updates 
PC-Display can prompt users to check online for software updates if that feature is 
enabled in the Default Configuration.  Access to the Vmed software download site is 
also available through the help menu.  Users may also update all software programs by 
accessing vmedtechnology.com and navigating to the “Downloads/Support” tab at the 
top.  There is no charge for software updates unless an install CD is required where 
there is a $15 charge. 

 

6.3 Troubleshooting PC-Display 
Consider the following situations for troubleshooting PC-Display. If you have any further 
questions then contact Vmed Support. 

Situation:   PC-Display does not connect to wireless remote monitor 

Possible Causes: 

 Weak batteries in wireless remote 
 Improper Bluetooth pairing 
 Bluetooth USB adapter not inserted into computer’s USB port 
 Windows Update may have re-enabled your Internal Bluetooth 

Corrective Action: 

 Check battery status on remote. 
 Re-initiate pairing procedure 
 Verify that USB Bluetooth adapter is plugged into computer (if no internal 

Bluetooth is present) 
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 If both internal and external Bluetooth adapters are present, disable one and 
restart the computer (and possibly re-pair remotes) 

 

Situation:   Bluetooth connection has range less than 50ft 

Possible Causes: 

 Low Batteries 
 Signal must pass through high attenuation barrier such as concrete floor/walls 

or heavy metal objects 
 Using built-in Bluetooth adapter with only 10 m range 

 

Corrective Action: 

 Check battery status on remote 
 Clear the signal path of obstructions 
 Disable computer’s built-in Bluetooth and use the Bluetooth device provided 

with wireless product 
 Update PC-Display software 

 

Situation:   PC-Display loses wireless connection with remote 

Possible Causes: 

 Wireless device out of range of computer or behind signal attenuator 
 Wireless device lost power 
 Bluetooth device loose in USB port 
 Computer turned off or PC-Display closed 

Corrective Action: 

 Move toward computer or clear attenuating obstacle 
 Cycle wireless device power switch 
 Recharge/Replace Batteries  
 Check Bluetooth device/USB connection 
 Restart PC-Display program 
 Update PC-Display software 
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Situation:   Cannot turn wireless remote device back on 

Possible Causes: 

 Batteries are totally discharged 
 User is pressing and holding power button 

Corrective Action: 

 Replace/recharge batteries 
 Press and immediately release the power button to turn on 
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Appendix A     Computer Requirements 
The following minimum computer requirements refer to a modern Windows 10 
computer. While PC-Display may still work fine with earlier Windows operating 
systems and computers, only Windows 10 with the below minimum requirements 
is officially supported at this time. 

 

NOTE: 
Windows 10 “S Mode” will not allow PC-Display to be installed. The S 
Mode will have to be disabled first (disabling S Mode cannot be 
undone). 

 

Computer Minimum Requirements 

CPU 2.5 GHz (PC desktop, laptop or tablet computer) 
MEMORY 4 GB RAM 
VIDEO RESOLUTION 1024 x 768 
CONNECTIONS Spare USB port (for external Bluetooth1 or 

installing software2) 
STORAGE 32 GB HD or SSD 

 

1  Some computers may come with internal Bluetooth which may be compatible with the 
Vmed wireless monitors, but in the cases where they are not compatible a USB 
Bluetooth adapter will need to be used. 

2 If a monitoring computer has no Internet Access then the USB port will need to be 
used for transporting the latest PC-Display software installer. Internet Access, 
however, is recommended for technical support purposes. 
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Appendix B     Software License Agreement 
 

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT CAREFULLY BEFORE DOWNLOADING OR 
USING THE SOFTWARE.  

BY CLICKING ON THE "I AGREE" AND THEN "NEXT >" BUTTONS, OPENING THE PACKAGE, 
INSTALLING THE PRODUCT, OR USING THE EQUIPMENT THAT CONTAINS THIS PRODUCT, YOU 
ARE CONSENTING TO BE BOUND BY THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE 
TERMS OF THIS AGREEMENT, CLICK THE "DO NOT AGREE" AND "CANCEL" BUTTONS AND THE 
INSTALLATION PROCESS WILL NOT CONTINUE, RETURN THE PRODUCT TO THE PLACE OF 
PURCHASE FOR A FULL REFUND, OR DO NOT INSTALL THE PRODUCT.  

EXCEPT AS EXPRESSLY AUTHORIZED ABOVE, CUSTOMER SHALL NOT: COPY, IN WHOLE OR IN 
PART, SOFTWARE OR DOCUMENTATION; MODIFY THE SOFTWARE; REVERSE COMPILE OR REVERSE 
ASSEMBLE ALL OR ANY PORTION OF THE SOFTWARE; OR RENT, LEASE, DISTRIBUTE, SELL, 
OR CREATE DERIVATIVE WORKS OF THE SOFTWARE.  

Multiple-Users License Grant: Vmed Technology ("Vmed") and its suppliers grant 
to Customer ("Customer") a nonexclusive and nontransferable license to use the 
Vmed software ("Software") in object code form for installation onto a hard 
disk or other storage device on: (i) an unlimited number of computers in the 
Customer’s facility; or (ii) a single local area network in the Customer’s 
facility for either of the following purposes: (a) for use exclusively with 
Vmed wireless monitors; or (b) use of the Software by consultants and 
contractors of the Customer for purposes of aiding the customer in the 
interpretation of clinical information in patient files transferred by the 
Customer to said consultants or contractors for the purpose of aiding in medical 
diagnosis. Customer may only use the programs contained in the Software (i) in 
accordance with paragraph (a) above; or in the case of an evaluation or 
demonstration copies, those programs Customer is authorized to evaluate.  

EXCEPT AS EXPRESSLY AUTHORIZED ABOVE, CUSTOMER SHALL NOT: COPY, IN WHOLE OR IN 
PART, SOFTWARE OR DOCUMENTATION; MODIFY THE SOFTWARE; REVERSE COMPILE OR REVERSE 
ASSEMBLE ALL OR ANY PORTION OF THE SOFTWARE; OR RENT, LEASE, DISTRIBUTE, SELL, 
OR CREATE DERIVATIVE WORKS OF THE SOFTWARE.  

Customer agrees that aspects of the licensed materials, including the specific 
design and structure of individual programs, constitute trade secrets and/or 
copyrighted material of Vmed. Customer agrees not to disclose, provide, or 
otherwise make available such trade secrets or copyrighted material in any form 
to any third party without the prior written consent of Vmed. Customer agrees 
to implement reasonable security measures to protect such trade secrets and 
copyrighted material. Title to Software and documentation shall remain solely 
with Vmed.  

LIMITED WARRANTY. Vmed warrants that for a period of ninety (90) days from the 
date of shipment from Vmed or its distributor: (i) the media on which the 
Software is furnished will be free of defects in materials and workmanship under 
normal use; and (ii) the Software substantially conforms to its published 
specifications. Except for the foregoing, the Software is provided AS IS. This 
limited warranty extends only to Customer as the original licensee. Customer's 
exclusive remedy and the entire liability of Vmed and its suppliers under this 
limited warranty will be, at Vmed or its service center's option, repair, 
replacement, or refund of the Software if reported (or, upon request, returned) 
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to the party supplying the Software to Customer. In no event does Vmed warrant 
that the Software is error free or that Customer will be able to operate the 
Software without problems or interruptions.  

This warranty does not apply if the software (a) has been altered, except by 
Vmed, (b) has not been installed, operated, repaired, or maintained in 
accordance with instructions supplied by Vmed, (c) has been subjected to 
abnormal physical or electrical stress, misuse, negligence, or accident, or (d) 
is used in hazardous activities.  

DISCLAIMER. EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL EXPRESS OR IMPLIED 
CONDITIONS, REPRESENTATIONS, AND WARRANTIES INCLUDING, WITHOUT LIMITATION, ANY 
IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE, 
ARE HEREBY EXCLUDED TO THE EXTENT ALLOWED BY APPLICABLE LAW.  

IN NO EVENT WILL VMED OR ITS SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT, 
OR DATA, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR PUNITIVE 
DAMAGES HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY ARISING OUT OF 
THE USE OF OR INABILITY TO USE THE SOFTWARE EVEN IF VMED OR ITS SUPPLIERS HAVE 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. In no event shall Vmed's or 
its suppliers' liability to Customer, whether in contract, tort (including 
negligence), or otherwise, exceed the price paid by Customer of the Software or 
wireless monitors. The foregoing limitations shall apply even if the above-
stated warranty fails of its essential purpose. SOME STATES DO NOT ALLOW 
LIMITATION OR EXCLUSION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES.  

The above warranty DOES NOT apply to any beta software, any software made 
available for testing or demonstration purposes or any temporary software 
modules. All such software products are provided AS IS without any warranty 
whatsoever.  

This License is effective until terminated. Customer may terminate this License 
at any time by destroying all copies of Software including any documentation. 
This License will terminate immediately without notice from Vmed if Customer 
fails to comply with any provision of this License. Upon termination, Customer 
must destroy all copies of Software.  

Software, including technical data, is subject to U.S. export control laws, 
including the U.S. Export Administration Act and its associated regulations, 
and may be subject to export or import regulations in other countries. Customer 
agrees to comply strictly with all such regulations and acknowledges that it 
has the responsibility to obtain licenses to export, re-export, or import 
Software.  

This License shall be governed by and construed in accordance with the laws of 
the State of Washington, United States of America, as if performed wholly within 
the state and without giving effect to the principles of conflict of law. If 
any portion hereof is found to be void or unenforceable, the remaining 
provisions of this License shall remain in full force and effect. This License 
constitutes the entire License between the parties with respect to the use of 
the Software. 
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